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CHAPTER 2

ANALYZING TRANSACTIONS: THE ACCOUNTING EQUATION

REVIEW QUESTIONS

1.

It is necessary to distinguish between business assets and liabilities and nonbusiness assets and
liabilities of a single proprietor because, according to the business entity concept, nhonbusiness
assets and liabilities are not included in the business entity’s accounting records. These distinctions
allow the owner to make decisions based on the financial condition and results of the business
apart from nonbusiness activities.

The six major elements of the accounting equation are listed below.

a. Assets are items owned by a business that will provide future benefits.

b. Liabilities are items owed to another business.

c. Owner’s equity is the amount by which the business assets exceed the business liabilities. Other
terms used for owner’s equity include net worth and capital.

d. Revenues represent the amount a business charges customers for products sold or
services performed.

e. Expenses represent the decrease in assets (or increase in liabilities) as a result of efforts made
to produce revenues.

f.  Withdrawals, or drawing, reduce owner’s equity as a result of the owner taking cash or other
assets out of the business for personal use.

The three basic questions that must be answered when analyzing the effects of a business
transaction on the accounting equation are as follows:

a. What happened?

b. Which accounts are affected?

c. How is the accounting equation affected?

The function of an income statement is to report the profitability of business operations for a specific
period of time.

The function of a statement of owner’s equity is to report the investments and withdrawals by the owner
and the profits and losses generated through operating activities for a specific period of time.

The function of a balance sheet is to report the assets, liabilities, and owner’s equity on a specific
date. It is called a balance sheet because it confirms that the accounting equation is in balance.

The three basic phases of the accounting process are listed below.

Input—Business transactions are used as input to the accounting process.

Processing—The transactions are processed by recognizing their effects on assets,
liabilities, owner’s equity, revenues, and expenses.

Output—Output from the accounting process is provided in the form of financial statements.
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Exercise 2-1A

Money in bank
Office supplies

Money owed
Office chairs

e

Net worth of owner

Money withdrawn by owner

Money owed by customers

Exercise 2-2A

Assets

$44.000

$32,000
$27,000

Exercise 2-3A

Assets

(@) 27,000
Bal. 27,000

(b) 7,500
Bal. 34,500
(©) (1,600)
1,600

Bal. 34,500
(d) (2,300)
Bal. 32,200

Account Classification
Cash A
Supplies ) A
Accounts Payable ) L
Office Furniture ; A
John Smith, Capital —_ OF
John Smith, Drawing ) OF
Accounts Receivable - A
Liabilities + Owner’s Equity
$ 27,000 + $17,000
$18,000 + $14.000
_$_7.000 . + $20,000
Liabilities + wner’s Equi
27.000
27,000
7,500
7,500 27,000
7,500 27,000
(2,300)
5,200 27,000
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Exercise 2-4A

Owner’s Equity

¢ 431dVvHO

Assets = Liabilities + —Capital———DBrawirg—+—Reveptes————Expenrses— Description
Bal.
from
2-3A
32.200 5.200 27.000
(d)
(e) 1,500 1,500 Service fees
)] (600) (600) Rent expense
g (64) (64) Phone expense
(h) (1,000) (1,000)
0] 750 750 Service fees
)] (1,200) (1,200) Wages expense
(k) 400
400
Bal. 31.586 5.200 27.000 (1.000) 2.250 (1.864)
Total Assets $31,586 Total Liabilities $ 5,200
Capital 27,000
Drawing (1,000)
Revenues 2,250
Expenses (1,864)
Total Liabilities and Owner’s Equity $31586
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Exercise 2-5A

Account Classification Financial Statement
Cash . A L BS
Rent Expense E IS
Accounts Payable L BS
Service Fees R IS
Supplies A BS
Wages Expense E IS
Ramon Martinez, Drawing OE SOE
Ramon Martinez, Capital OE . SOE. BS
Prepaid Insurance A BS
Accounts Receivable A . BS
Exercise 2-6A
Betsy Ray’s Accounting Service
Statement of Owner’s Equity
For Month Ended June 30, 20--
Betsy Ray, capital, June 1, 20-- $ —_L
Investment during June 20,000
Total investment — $20,000
Net income for June $10,000 _
Less withdrawals for June 8,000 _
Increase in capital - 2,000
Betsy Ray, capital. June 30, 20-: $22,000
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CHAPTER 2
Exercise 2-7A

Betsy Ray’s Accounting Service
Statement of Owner’s Equity For

Month Ended June 30, 20--

Betsy Ray, capital, June 1, 20-- $

Investment during June 20,00¢

Total investment $20,000

Less: Net loss for June $3,000 _
Withdrawals for June 8,000

Decrease in capital (11, 00)

Betsy Ray, capital, June 30, 20-- @9,

Problem 2-8A
Assets = Liabilities + Owner’s Equity
1. $26.960 $ 7.550 . $19.410
2. $35.500 $ 10910 $24.590
3. $32.040 $ 12910 _—$19130
Problem 2-9A: See page 10
Problem 2-10A
Jay Pembroke
Income Statement
For Month Ended April 30, 20--
Revenues:
Service fees $3,300
Expenses:
Rent expense 750

Net income $2,550
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Problem 2-9A

Assets = Liabilities + Owner’s Equity
Amts.
(Items Owned) Qwed) (Owner'g Investment) (Earnings)
Accounts Office Prepaid Accounts J. Pembroke, J. Pembroke,
4_Cash -+ _Recejvable +_ Supplies + Insurance = __Pavable -+ Capital = Jrawing  __+ Revenues — Expenses Jescription

1
8
0
0
(@) 18.000 ; 0
(
2
0
0
0
(b) 1 4.600 2.600
c (1.200) 1.200
1 2
3 0
0 0
(d 9 0 3.300 Service fees
(
2
3
0
0
(e) (2.300)
(
7
5
0
" — 750  _Rentexpense
(
1
0
0
@ 2 —_— 66

Bal. 12.950 2.000 4,600 1.200 300 18.000 100 3.300 750




Cash
Accounts Receivable

Office Supplies
Prepaid Insurance
Total Assets

$12,950
2,000

4,600

$20.750

Accounts Payable

Jay Pembroke, Capital

Jay Pembroke, Drawing

Service Fees

Rent Expense

Total Liabilities and Owner’s Equity

$ 300

18,000
(100)

3,300
—(120)

$20,750
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11

CHAPTER 2
Exercise 2-1B
Problem 2-11A
Jay Pembroke Statement of
. Owner’s Equity For Month
. Ended April 30, 20--
Jay Pembroke, capital, April 1, 20-- $
Investment during April 18,
Total investment $18,000
Net income for April $2,550
Less withdrawals for April 100
Increase in capital 2,450
Jay Pembroke, capital, April 30, 20-- $20,450
Problem 2-12A
Jay Pembroke
Balance Sheet
April 30, 20--
Assets Liabilities
Cash $12,950| Accounts payable $ 300
Accounts receivable 2,000
Office supplies 4,600 Owner’s Equity
Prepaid insurance 1,200| Jay Pembroke, capital 20,450
Total assets $20,750( Total liab. & owner’s equity $ 20,750

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.



12 CHAPTER 2

Exercise 2-1B

Account

Cash

Accounts Payable

Supplies

Bill Jones, Drawing

Prepaid Insurance

Accounts Receivable

Bill Jones, Capital

Exercise 2-2B

Assets

$25.000

$30,000
$20,000

Exercise 2-3B

(@)

Bal.

(b)

Bal.

(©)

Bal.

(d)

Bal.

Assets
30.000

30,000

4,500

34,500

1,600

(1,600)

34,500

(2,000)

32,500

CHAPTER 2

Classification
_ A
_ L
I A
QE
——A
——A
__ — OF
Liabilities Owner’s Equity
$20,000 $ 5,000
$15,000 $ 15.000
$10.000 $ 10,000
Liabilities Owner’s Equity
— 30,000
30,000
4,500
4,500 30,000
4,500 30,000
(2,000)
2,500 30,000
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Exercise 2-4B

Owner’s Equity

Assets = Liabilities + Capital Drawing+Revenues Expenses Description
Bal.
from
2-3B
(d) fe¥4Re]V]V] p4Re]V]V) SQ.QUY
(e) 3,000 3,000 Service fees
® (1,000) 1,000 Rent expense
g (68) 68 Phone expense
(h) (800) 800
0] 900 900 Service fees
)] (500) 500 Wages expense
(k) 500
(500)
Bal. 34,032 2,500 30.000 800 3900 __ 1,568
Total Assets $34,032 Total Liabilities $ 2,500
Capital 30,000
Drawing (800)
Revenues 3,900
Expenses -{1.568)
Total Liabilities and Owner’s Equity $34.032
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Exercise 2-5B

Account Classification Financial Statement
Cash . A . BS
Rent Expense E IS
Accounts Payable L BS
Service Fees R IS
Supplies A BS
Wages Expense E IS
Amanda Wong, Drawing OE SOE
Amanda Wong, Capital OF SQE. BS
Prepaid Insurance A BS
Accounts Receivable A ________BS
Exercise 2-6B
Lopez Financial Consulting
Statement of Owner’s Equity
For Month Ended June 30, 20--
Efran Lopez, capital, June 1, 20-- $ —
Investment during June 15,000
Total investment _ $15,000
Net income for June — $6,000 —
Less withdrawals for June — 7,000 —
Decrease in capital (1,000)
| Efran_Lopez. capital, June 30, 20-- _ $14,000
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14 CHAPTER 2 CHAPTER 2 15

Exercise 2-5B
Exercise 2-7B

Lopez Financial Consulting
Statement of Owner’s Equity

__For Month Ended June 30, 20-- .

Cfran | nno—2 oan 1ital loanea 1 20 [d
Investment during June 15, 000
Total investment $15.000_|
Less: Net loss for June $2,000 L
4 — Withdrawals forJune 7,000 4
Decrease in capital (9,000)
_| Efran Lopez, capital, June 30, 20-- R $ 6,000
Problem 2-8B
Assets = Liabilities + Owner’s Equity
1. $22.860 $ 4605 _ $18.255
2. $27.425 $ 8515 $18.910
3. $25.235 $ 10.165 $15.070
Problem 2-9B: See page 16
Problem 2-10B
David Segal
Income Statement
For Month Ended October 31, 20--
Revenues:
Service fees $2,700
Expenses:
Rent expense 650
$2,050

Net income
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Problem 2-9B
Assets = Liabilities Owner’s Equity
(Amts.
—_— (ltems Qwned) — Qwed) -—{Qwpner’s Investment) - - {Earnings)
Accounts Office Prepaid Accounts D. Segal, D. Segal,

| Cash + Receivable + Supplies + Insurance =  Payabje + Cap
(@ 15,000 15,C
(b) (1,800) 3,800 2,000
c (1,000) 1,000
(d) 1,700 1,000
(e) (1,800) (1,800)
U] (650)
(9) (150)
Bal. 11,300 1,000 3,800 1,000 200 15,C
Cash $11,300 Accounts Payable $ 200
Accounts Receivable 1,000 David Segal, Capital 15,000
Office Supplies 3,800 David Segal, Drawing (150)
Prepaid Insurance 1.000 Service Fees 2,700
Total Assets $17,100 Rent Expense (650)

Total Liabilities and Owner’s Equity $1/,100

¢ 431dVHO



14 CHAPTER 2 CHAPTER 2 17
Problem 2-11B
. David Seqal
. Statement of Owner’s Equity
For Month Ended October 31, 20--
David Segal, capital, October 1, 20-- $
Investment during October 15,000
Total investment $15,000
Net income for October $2,050
Less withdrawals for October 150
Increase in capital 1,900
David Segal, capital, October 31, 20-- $16,900
Problem 2-12B
David Segal
Balance Sheet
October 31, 20--
Assets Liabilities
Cash $11,300| Accounts payable $ 200
Accounts receivable 1,000
Office supplies 3,800 Owner’s Equity
Prepaid insurance 1,000| David Segal, capital 16,900
Total assets $17,100( Total liab. & owner’s equity $ 17,100

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.
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15 CHAPTER 2 CHAPTER 2 17

MANAGING YOUR WRITING

The students should focus on the following differences:

1. Anexpense is an outflow of assets or increase in liabilities as a result of the efforts made to earn
revenues. A withdrawal is an outflow of assets for the owner’s personal use. The withdrawal is
not related to the earning process.

2. A withdrawal that increases a liability would be unusual. Expenses often increase liabilities.

The student should focus on the following similarity:
1. Expenses and withdrawals reduce owner’s equity.

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.
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Mastery Problem

1.

@)
(b)

(d)
(e)
®
@
(h)
0]
0)
(k)
()
(m)

(0)
()

Bal.

| Assets = Liabilities + Owner’s Equity
(Amts.
(Items Owned) Owed) (Owner’s Investment) (Earnings)
| Accts. Sgp- Prepaid Accts. L. Voz_niak, L. Vo;niak, o
Cash + Rec. + plies + Ins. + Tools + Van = Payable + Capital — Drawing Rev. - Exp. Description
8,000 8,000
(150) 150 Rent expense
(5,000) 5,000
600 600
(200) 300 100
(100) 100 Wages expense
(75) 75 Adver. expense
(480) 480
800 800 Cleaning fees
500 500 Cleaning fees
(40) 40 Phone expense
200 (200)
(150) 150 Wages expense
(200) (200)
600 200 800 Cleaning fees
(100) 100
3.105 500 300 480 600 5.000 500 8.000 100 2.100 515

¢ 431dVHO
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20 CHAPTER 2 CHAPTER 2 21

Mastery Problem (Continued)
3.

We Do Windows,
Income Statement
For Month Ended July 31, 20--

Revenues:
Cleaning fees $2,100
Expenses:
Wages expense $250
Rent expense 150
Advertising expense 75

Phone expense 40
Total expenses 515
Net income $1,585

We Do Windows
Statement of Owner’s Equity
For Month Ended July 31, 20--

Lisa Vozniak, capital, July 1, 20-- $ —

Investment in July 8,000
Total investment $8,000
Net income for July $1,585
Less withdrawals for July 100

Increase in capital 1,485
Lisa Vozniak, capital, July 31, 20-- $9,485

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.
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Mastery Problem (Concluded)
5.
We Do Windows

Balance Sheet

July 31, 20--
Assets Liabilities

Cash $3,105| Accounts payable $ 500
Accounts receivable 500

Supplies 300

Prepaid insurance 480

Tools 600 Owner’s Equity

Van 5,000| Lisa Vozniak, capital 9,485
Total assets $9,985| Total liab. & owner’s equity $ 9,985

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.



22 CHAPTER 2 CHAPTER 2 21

Challenge Problem

Cash from customers $3,700
Cash paid for wages $450
Cash paid for rent 300
Cash paid for utilities 50
Cash paid for insurance 600
Cash paid for supplies 100
Cash paid for phone 35
Total cash paid for operating items 1,535

Difference between cash received from customers and

cash paid for goods and services $2,165

Yes, there is a difference of $2,000. Net income does a better job of measuring profits because it offers a
better matching of revenues and expenses. However, cash flows are important. If you don’t have enough
cash to pay your bills, you will go out of business.

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.



3 ChapZeepter 2 Analyzing Transactions: The Accounting Equation

CHAPTER 2

REVIEW QUESTIONS

accounting equation
business entity
asset

liability

account payable
owner’s equity
business entity
Owner’s Equity
Liabilities

10. Owner’s Equity

©CoNoOR~wNE

EXERCISES

Exercise 1

()  $24,000 (b)  $17,000

Exercise 2
@  $90,000 (c)  $60,000
(b)  $35,000 (d)  $55,000
Exercise 3

Net income = $7,000

Exercise 4

Owner’s equity = $13,120

Exercise 5

(@) $16,000 (b) $2,880 net income

11.
12.
13.
14.
15.
16.
17.
18.
19.

expense

net income

net loss

fiscal year

drawing

income statement
statement of owner’s equity
balance sheet

liquidity
(c) $40,000
(e) $50,000
(f) $10,000

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.
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4 Chatérpter 2

Analyzing Transactions: The Accounting Equation

Exercise 6
OWNER’S
ASSETS = LIABILITIES + EQUITY
@) 15,000 15,000
Bal. 15,000 15,000
(b) (4,000)
4,000
Bal. 15,000 15,000
(©) 9,000 9,000
Bal. 24,000 9,000 15,000
(d) (2,000) (2,000)
Bal. 22,000 = 7,000 + 15,000
Exercise 7
ASSETS = LIABILITIES + OWNER’SE QUITY
(ItemsOwned)  (Amts. Owed) (Owner’s Investment) (Earnings)
Accounts Glen Ross, Glen Ross,
Cash Payable Capital - Drawing + Revenues - Expenses Description

Bal. 28,000 8,000 20,000

@) 4,000 4,000 Service Fees

(o) (1,200) 1,200 Rent Exp.

(©) (200) 200 Utilities Exp.

(d) (600) 600

Bal. 30,000 = 8.000 + 20,000 600 + 4000 - 1.400

30,000 = 30,000
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5 ChapZeepter 2 Analyzing Transactions: The Accounting Equation 5
Exercise 8
1.
ASSETS = LIABILITIES + OWNER’S EQUITY
(Items Owned) (Amts. Owed)  (Owner’s Investment) (Earnings)
Offite ACCOUTTLS J. IVIOOTE, J. IVIOOTE,
Cash + Equipment = Payable + Capital — Drawing + Revenues — Expenses Description
(@) 10,000 10,000
(b) 5,500 5,500
(c) 900 900 Service Fees
(d) (6,000) 6,000
(e) 1,500 1,500 Service Fees
f (800) 800 Rent Exp.
(9) (75) 75 Phone. Exp.
(h) (100) (100)
() (500) 500
Bal. % + 11500 = 5.400 +10.000 5&.0 + i“ﬂ S—E
| 16,425 | = | 16,425
2.
Totl et $ 16,425
Tl NS $ 5,400
OWEES QU $ 11,025
Owner’s equity in excess of original investment....... $ 1,025
Totl revenes $ 2,400
Totl expenses $ 875
Netncome $ 1525

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.
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6 ChapZeepter 2 Analyzing Transactions: The Accounting Equation 6

Exercise 9
. Judith Moore Enterprises
. Income Statement
For Month Ended July 31, 20--
Revenue:
Service fees $2,400
Expenses:
Rent expense $800
Phone expense 75
Total expenses 875
Net income $1525 [
Exercise 10
_ Judith Moore Enterprises
_ Statement of Owner’s Equity
. For Month Ended July 31, 20--
Judith Moore, capital, July 1, 20-- $ —
Investment in July 1,000
Total investment $1C,000
Net income for July $1,525
Less withdrawals for July 500
Increase in capital 1,025
Judith Moore, capital, July 31, 20-- $11,025

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.
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7 ChapZeepter 2 Analyzing Transactions: The Accounting Equation 7

Exercise 11
Judith Moore Enterprises
Balance Sheet
July 31, 20--
ASSETS LIABILITIES
Cash $ 4,925| Accounts payable $ 5,400
Office equipment 11,500
OWNER’S EQUITY

Judith Moore, capital 11,025

Total assets $ 16,425| Total liabilities and owner’s equity $ 16,425
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8 ChapZeepter 2 Analyzing Transactions: The Accounting Equation

PROBLEMS
Problem 12
ASSETS = LIABILITIES + OWNER’S EQUITY
1. $18,800 $4,700 $14,100
2. $23,400 $7,200 $16,200
3. $21,900 $6,000 $15,900

4, Net income for January = $2,100
Net loss for February = $300

Problem 13
1.
ASSETS = LIABILITIES + OWNER’S EQUITY
(Amts.
(Items Owned) Owed) (Owner’s Investment) (Earnings)
Office Prepaid  Accounts J. Moore, J. Moore,

Cash + Equip. + Insur. = Payable + Capital — Drawing + Revenues — Expenses Description
(@ 12,000 12,000
(b) 7,500 7,500
(c) (800) 800
(d) 700 700 Cons. Fees
(e) (600) 600  Rent Exp.
(j)] (150) 150  Wages Exp.
(9) (200) 200
(h) (3,000) (3,000)
(i) (100) - - 100 - —_

o
1
S~
a1
o
o
+
—
N
o
o
o

\
—
o
+
-~
o
o

|
~J
a1
o

Bal. 1785 + 8300 + 20

16,350 16,350

© 2017 Cengpgolr@aigagé Aty RaseRightMsanide Mapnest sermeedupinated: dupavakdo ariptlisitaecessinltayahsitsitin whsier in Pafble or in part.



9 ChapZeepter 2 Analyzing Transactions: The Accounting Equation 9

Problem 13 (Concluded)

2.
TOLAL BSSPLS. ..ttt ettt ettt et et e e et et e e st et e e e et e et eeeeenens $ 16,350
TOtAl HADIIIEIES ..veveeeee ettt s $ 4,500
OWNEL’S BQUILY.....vvevevercvireeiee et rereee e s et bes s $ 11,850
Change in owner’s equity from original investment...................... $  (150)
TOtAl FEVENUES ...vevveicverce ettt e $ 700
TOtAl EXPENSES.......cvirieeeieieerieieiee ettt $ 750
NEL INCOME (10SS) ..vvevvvirireeiieie ettt $ (50)
Problem 14
. Susan Cole Consulting Services
. Income Statement '
. For Month Ended October 31, 20—
Revenue:
Consulting fees $700
Expenses:
Rent expense $600
Wages expense 150
Total expenses 750
Net income (loss) $ (50)

© 2017 Cengpgolr@aigagé Aty RaseRightMsanide Mapnest sermeedupinated: dupavakdo ariptlisitaecessinltayahsitsitin whsier in Pafble or in part.



10 Chaphepger 2

Problem 15

Analyzing Transactions: The Accounting Equation

Susan Cole Consulting Services

Statement of Owner’s Equity

For Month Ended October 31, 20--

Susan Cole, capital, October 1, 20-- $—
Investment in October 12,000
Total investment $12,000
Less: Net loss for October $ 50

Withdrawals for October 100
Decrease in capital (150)
Susan Cole, capital, October 31, 20-- $11,850

Problem 16
Susan Cole Consulting Services
Balance Sheet
October 31, 20--
ASSETS LIABILITIES
Cash $ 7,850 Accounts payable $ 4,500
Prepaid insurance 200
Office equipment 8,300 OWNER’S EQUITY
Susan Cole, capital 11,850

Total assets $ 16,350| Total liabilities and owner’s equity $ 16,350

© 2017 Cengpgolr@aigagé Aty RaseRightMsanide Mapnest sermeedupinated: dupavakdo ariptlisitaecessinltayahsitsitin whsier in Pafble or in part.

10



11 Chaphepger 2

Analyzing Transactions: The Accounting Equation 11

Problem 17
1.
ASSETS = LIABILITIES + OWNER’S EQUITY
(Amts.
(Items Owned) Owed) (Owner’s Investment) (Earnings)
Accounts Office Accounts S. Cassady, S. Cassady,
Cash  + Receivable. + Supplies = Payable + Capital - Drawing + Revenues — Expenses Description
(@) 10,000 10,000
(b) (200) 200
(©) (400) 800 400
(d) 300 300 Typing Fees
(e) (600) 600  Rent Exp.
() (100) 100
(9) 200 400 600 Typing Fees
(h) (200) (200)
(1 200 (200)
Bal. 9,200 + 200 1,000 = 200 + 10,000 - 100 + 900 - 600
10,400 = 10,400

© 2017 Cengpgolr@aigagé Aty RaseRightMsanide Mapnest sermeedupinated: dupavakdo ariptlisitaecessinltayahsitsitin whsier in Pafble or in part.




12 Chaphepger 2

Problem 17 (Concluded)
2.

Analyzing Transactions: The Accounting Equation

Stuart Cassady Typing Service

Income Statement

For Month Ended April 30, 20--

Revenue:
Typing fees $900
Expense:

Rent expense 600
Net income $300
Stuart Cassady Typing Service
Statement of Owner’s Equity
For Month Ended April 30, 20--

—| Stuart Cassady, capital, April 1, 20-- $— |
Investment in April 11—
Total investment $10,000
Net income for April $300
Less withdrawals for April 100
Increase in owner’s equity 200
Stuart Cassady, capital, April 30, 20-- $10,200

Stuart Cassady Typing Service
Balance Sheet
April 30, 20--
ASSETS LIABILITIES
Cash $ 9,200| Accounts payable $ 200
Accounts receivable 200
Office supplies 1,000 OWNER’S EQUITY
Stuart Cassady, capital 10,200
Total assets $10,400]| Total liabilities and owner’s equity $10,400

© 2017 Cengpgolr@aigagé Aty RaseRightMsanide Mapnest sermeedupinated: dupavakdo ariptlisitaecessinltayahsitsitin whsier in Pafble or in part.
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M-4 MODULE
Exercise M-2A

COMBINATION JOURNAL

CASH BOST.
PATE DEBIT CREDIT PESLRIFTIVN REF.
20--
1|Oct. 1 15]0J0]Of 00 Bill Rackes, Capital 1
2 2 3]0]0] 00JRent Expense 2
3 3 Bicycle Parts 3
4 Accounts Payable—Tracker’s Bicycle Parts 4
5 5 Office Supplies 5
6 Accounts Payable—Downtown Office Supplies 6
7 8 38| 00]Phone Expense 7
8 1]4]0] 00 — |
9 11 1]15] O0jMiscellaneous Expense 9
10 12 1]0]0] 00jAccounts Payable—Tracker’s Bicycle Parts 10
1 14 3|0]0] 00 — |Ju
12 15 3]|5]0] 00 — |
13 16 4] 8] 00jUtilities Expense 13
14 19 2|5]0f 00 — |
15 23 5|0] 00]Bill Rackes, Drawing 15
16 25 5]0] 00]Accounts Payable—Downtown Office Supplies 16
17 29 3]0]0] 00 — |4
18 15]7]4]0] 00| 1{2]0j1 00 18
19 19
20 20
21 21
22 22
23 23
24 24
25 25
26 26
27 27
28 28
Proving the Combination Journal:

Debit columns: Credit columns:

Cash $15,740 Cash $ 1,201

General 2,851 General 17,250

Wages Expense 600 Repair Fees 740
$19,191 $19,191

© 2017 Cengage Learning. All Rights Reserved. May not be scanned, copied or duplicated, or posted to a publicly accessible website, in whole or in part.



MODULE
Exercise M-2A (Concluded)

PAGE 1
GENERAL REPAIR FEES | WAGES EXPENSE]
DEBIT CREDIT CREDIT DEBIT
1 15000 00 1
2 00 2
3 00 3
4 2(0]0j 0 00 4
5 2/ 50| 00 5
6 2(5/0 00 6
7 3|18 | 00 7
8 1} 4/ 0] 00 8
9 00 9
10 1 0|0 | 00 10
11 3] 0| Of 00|11
12 3] 5[0 00 12
13 481 00 13
14 2| 5[0 00 14
15 00 15
16 00 16
17 3 0] 0] 00[17
18 815100 17|2|50 00 7] 4|0 00 6] 0| Of 00|15
19 19
20 20
21 21
22 22
23 23
24 24
25 25
26 26
27 27
28 28

M-5
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Chapter 2
Analyzing Transactions: The Accounting Equation

Learning Objectives

LO1
LO2
LO3
LO4
LOS

LOG6

Define the accounting elements.

Construct the accounting equation.

Analyze business transactions.

Show the effects of business transactions on the accounting equation.
Prepare and describe the purposes of a simple income statement, statement
of owner’s equity, and balance sheet.

Define the three basic phases of the accounting process.

Teaching Tips

LO1

The definitions for the accounting elements are very important. Often students
find memorizing definitions to be boring. Be sure to spend sufficient class time
to ensure a solid understanding of these definitions. Throughout the course,
students should be expected to identify the accounting elements represented
by the accounts used in transactions.

Now would be a good time to point out to your students that, at the end of this
chapter and all subsequent chapters, there is a fully worked-out
demonstration problem, which will aid them in completing and understanding
their assignments.

The Accounting Elements
A A business entity is an individual, association, or organization that engages
in economic activities and controls specific economic resources.

B. Assets
1. Items owned by the business entity and will provide future benefits.
2. Cash, merchandise, fixtures, machinery, buildings, and land are examples
of assets.
3. Accounts receivable—money owed to the business by its customers

—on accountl or —on creditl

C. Liabilities

1. Amounts owed to another business entity.
2. Accounts payable an unwritten promise to pay a supplier for assets.
3. Notes payable a formal written promise to pay a supplier or lender.

D. Owner’s Equity

1. The amount by which all business assets exceed the business liabilities.
2. Also called net worth and/or capital.
3. The owner may have business assets/liabilities and nonbusiness

assets/liabilities. According to the business entity concept, nonbusiness



assets/liabilities must not be included in the business entity’s
accounting records.

In-Class Exercise: Complete Exercises E2-1A, E2-1B (5 minutes each)

LO2

1. The Accounting Equation
A.Assets = Liabilities + Owner’s Equity

Teaching Tip

The left side of the equation represents the assets. The right side of the
equation shows where the money came from to buy the assets. When two
elements are known, the third can always be calculated.

In-Class Exercise: Complete Exercises E2-2A, E2-2B (5 minutes each)
In-Class Exercise: Complete Problems P2-8A, P2-8B (5 minutes each)

LO3
1" Analyzing Business Transactions
A. A business transaction is an economic event; an event measured in dollars and has
a direct impact on the business.
B. All transactions affect at least two accounts, which are separate records used to
summarize changes in each asset, liability, and owner’s equity of the business.
C. Account titles provide a description of each type of account.
D. Three basic questions must be answered for each transaction:
1. What happened?
2. Which accounts are affected?
a) Identify the accounts.
b) Classify the accounts.
3. How is the accounting equation affected?
a) Determine which accounts increased or decreased.
b) Ensure the accounting equation remains balanced.
LO4
Teaching Tip

At the end of this Learning Objective (LO4), Figure 2-1 Summary of
Transactions lllustrated can be used by students to see how the
following transactions fit into the “big picture” on a step-by-step basis.

10
10



V. Summary of Transactions Illustrated (See Figure 2-1)
Effect of Transactions on the Accounting Equation
A. Transaction (a): Investment by owner
1. An increase in an asset (Cash) is offset by an increase in owner’s equity
(Rohan Macsen, Capital).

Teaching Tip
Remember, Capital does not mean Cash. The cash is shown in the cash
account.
B. Transaction-(b): Purchase of an asset for cash
1. An increase in an asset (Delivery Equipment) is offset by a decrease
in another asset (Cash).
Teaching Tip

Students often think that both sides of the accounting equation must be
affected by a transaction. Point out that this is not true.

C. Transaction (c): Purchase of an asset on account
1. An increase in an asset (Delivery Equipment) is offset by an increase in
a liability (Accounts Payable).

Teaching Tip

Many students find Accounts Payable and Accounts Receivable and
payments on those accounts confusing. It may be advisable to spend extra
time explaining what “payment on account” means. One idea is to stress that
whatever purchase or sale created the liability or receivable was in the past.
The transaction has been completed. Accounts Receivable refers to a
transaction between the business and its customers and Accounts Payable
refers to a transaction between a vendor/creditor and the business.

D. Transaction (d): Payment on a loan
1. A decrease in an asset (Cash) is offset by a decrease in a liability
(Accounts Payable).

In-Class Exercise: Complete Exercises E2-3A, E2-3B (10 minutes each)

V. Expanding the Accounting Equation: Revenue, Expenses, and Withdrawals
A.Revenues
1. The amount charged to customers for goods and services.
2. Separate revenue accounts may be used.
3. Revenues increase both assets and owner’s equity.
Teaching Tip

11 11



Revenue is not Cash. Revenue is recorded when earned through the sale of
a product or providing a service. If cash is received as a result, the cash

12 1o



account is increased. If not, another asset, Accounts Receivable, is

increased.
B. Expenses
1. Created as a result of business operating activities that involve selling
a product or providing services.
2. Expenses either decrease assets or increase liabilities.
3. Expenses reduce owner’s equity.
Teaching Tips

Students often confuse expenses and liabilities. Reinforce the definitions. An
expense is the outflow of resources (decrease in assets or increase in
liabilities) as a result of efforts made to produce revenues. The main purposes
of recognizing an expense are to keep track of the amount and types of
expenses incurred and to show the reduction in owner’s equity. Note that an
expense can cause a reduction in assets or an increase in liabilities. Wages
earned by employees is a good example. If paid, the expense reduces an
asset, Cash. If not paid, it increases a liability, Wages Payable.

Students often think that the expense account should be decreased when
expenses are incurred. Stress that each time an expense is incurred, it is
recorded and added to the previous amount so that total expenses can be

determined.
4. Net income or net loss
a) If revenues are greater than expenses, the business has a net income.
b) If revenues are less than expenses, the business has a net loss.
5. Fiscal year
a) The concept that income determination can be made on a
periodic basis is the accounting period concept.
b) Any accounting period for 12 consecutive months for which
business records are kept; generally coinciding with a calendar year.
C. Withdrawals or Drawing
1. Amounts taken from the business by the owner for personal use.
2. Withdrawals reduce assets.
3. Withdrawals reduce owner’s equity.
VI. Effect of Revenue, Expense, and Withdrawal Transactions on the Accounting Equation
A Transaction (e): Delivery revenues earned in cash
1. An increase in an asset (Cash) is offset by an increase in owner’s equity
resulting from an increase in the revenue account (Delivery Fees).
B. Transaction (f): Paid rent for month
1. A decrease in an asset (Cash) is offset by a decrease in owner’s equity

resulting from an increase in an expense account (Rent Expense).

13 13



Teaching Tip

Students often think that expenses and drawing should have minus signs.
Point out that as these items increase, owner’s equity decreases.

C. Transaction (g): Paid phone bill
1. A decrease in an asset (Cash) is offset by a decrease in owner’s equity
resulting from an increase in an expense account (Phone Expense).

D. Transaction (h): Delivery revenues earned on account
1. An increase in an asset (Accounts Receivable) is offset by an increase in
owner’s equity resulting from an increase in the revenue account
(Delivery Fees).

E. Transaction (i): Purchase of supplies
1. An increase in an asset (Supplies) is offset by a decrease in an asset (Cash).
F. Transaction (j): Payment of insurance premium
1. An increase in an asset (Prepaid Insurance) is offset by a decrease in an
asset (Cash).
Teaching Tip

If you think that the students are ready, you might mention that supplies and
insurance used (expired) during this accounting period will be recognized as
expenses. These “adjustments” will be discussed later.

G. Transaction (k): Cash receipts from prior sales on account
1. An increase in an asset (Cash) is offset by a decrease in an asset
(Accounts Receivable).
2. The accounting equation in unchanged, an asset, cash, increases and

another, accounts receivable, decreases in an equal amount.

H. Transaction (I): Purchase of an asset on account making a partial payment
1. An increase in an asset (Equipment) is offset by a decrease in an asset
(Cash) and an increase in a liability (Accounts Payable).

I Transaction (m): Payment of wages
1. A decrease in an asset (Cash) is offset by a decrease in owner’s equity
resulting from an increase in an expense account (\Wages Expense).

J. Transaction (n): Deliveries made for cash and on account
1. An increase in two assets (Cash and Accounts Receivable) is offset by an
increase in owner’s equity from an increase in a revenue account
(Delivery Fees).

K. Transaction (0): Withdrawal of cash from business
1. A decrease in an asset (Cash) is offset by a decrease in owner’s equity
(Rohan Macsen, Drawing) resulting from a withdrawal by the owner.
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Teaching Tip

Point out that the owner does not receive a salary from the business. Cash or
other assets are withdrawn to meet living expenses. The amount withdrawn
depends on the personal needs of the owner. This amount may be more or
less than net income in any given year.

In-Class Exercise: Complete Exercises E2-4A, E2-4B (20 minutes each)
In-Class Exercise: Complete Problems P2-9A, P2-9B (5 minutes each)

LO5
VII. Financial Statements

Teaching Tip

It may be helpful to tell students that the headings to the financial statements
answer three questions: Who? What? When?

A. The Income Statement (See Figure 2-2)

1. Sometimes called the profit and loss statement or operating statement.
2. Reports the profitability of a business for a specific time period.
3. Revenue — Expenses = Net Income or Net Loss.

In-Class Exercise: Complete Problems P2-10A, P2-10B (10 minutes each)

B. The Statement of Owner’s Equity (See Figure 2-2)

1. Reports the activities in the owner’s equity for a specific time period.
2. Investments and Net Income increase capital.
3. Withdrawals and Net Losses decrease capital. (See Figure 2-3)

In-Class Exercise: Complete Exercises E2-6A, E2-6B (10 minutes each)
In-Class Exercise: Complete Exercises E2-7A, E2-7B (10 minutes each)
In-Class Exercise: Complete Problems P2-11A, P2-11B (15 minutes each)

C. The Balance Sheet (See Figure 2-2)

1. Reports the assets, liabilities, and owner’s equity on a specific date.

2. Sometimes called a statement of financial position or statement
of financial condition.

3. Assets = Liabilities + Owner’s Equity

In-Class Exercise: Complete Problems P2-12A, P2-12B (10 minutes each)

D. Guidelines for Preparing Financial Statements
1. Standard formats should be used.
2. Headings should be used on all statements.
3. Single underlines should be used to add or subtract numbers above the

line; double underlines indicate a total.
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4. Dollar signs are used at the top of columns and beneath single
(subtotal) underlines.

Expenses may be listed from highest to lowest dollar amount.
Assets are listed from most liquid to least liquid.

Liabilities are listed from most current to the least current.

No o

In-Class Exercise: Complete Exercises E2-5A, E2-5B (10 minutes each)

LOG6
VIII.  Overview of the Accounting Process (See Figure 2-4)
A Input. Business transactions provide the necessary information for input.
B. Processing. Recognizing the effect of transactions on the assets, liabilities,
owner’s equity, revenues, and expenses of a business.
C. Output. Recording the processed information on financial statements.

Learning Activities

1. Ask students to talk with the manager of a small business to identify the types of expenses in
the business.

2. Students should be able to identify the difference between the six different types of accounts.
Classifying accounts correctly in these early chapters is a must. The instructor should ask the
students to give numerous examples of the types of accounts. Find out if the students know the
difference between an asset and an expense. Ask the students to explain the difference
between Accounts Payable and Accounts Receivable. Have them explain the effect of a
—payment on accountl by the business and by a customer.

Critical Thinking Activity

Mark Hahn invested $26,000 in cash to open a law office on April 28 of the current year. On April
29, he purchased office equipment for $10,800. He paid cash for all but $1,550 of the office
equipment. On April 30, Mark paid $1,200 for six months’ insurance for his law practice. Mark
wants to know the financial condition of his business as of April 30.

Solution
Mark Hahn, Attorney at Law
Balance Sheet
April 30, 20--
Assets Liabilities
Cash $15,550 Accounts Payable $ 1,550
Prepaid Insurance 1,200 Owner’s Equity
Office Equipment 10,800 Mark Hahn, Capital $26.000
Total Assets $27,550 Total Liabilities and Owner’s Equity ~ $27.550
15

15



| Homework Suggestions

LO1 Study Guide Review Questions 2, 3, 4, 5, 7; End of Chapter Review Question
1,2

LO2 Study Guide Review Questions 1, 6, 8, 9, 10; Study Guide Exercises 1, 4, 5;
Study Guide Problem 12

LO3 End of Chapter Review Question 3

LO4 Study Guide Review Questions 11, 12, 13, 14, 15; Study Guide Exercises 2,
6, 7, 8; Study Guide Problem 13; End of Chapter Review Question 2

LO5 Study Guide Review Questions 16, 17, 18, 19; Study Guide Exercises 3, 9,
10, 11; Study Guide Problems 14, 15, 16, 17; End of Chapter Review
Questions 4, 5, 6

LO6 End of Chapter Review Question 7

Entire Chapter:
Managing Your Writing, Mastery Problem, and Challenge Problem

Can people be an asset?

Can an asset be something you cannot touch or see?

Is a lease you are obligated to pay a liability?

Do you always use two or more accounts in a journal entry?

Is capital the same as cash?

Shouldn’t liabilities be subtracted?

How do we keep track of different receipts of cash from different people who owe us?
Whom do we ask if we don’t understand what a particular transaction means?

Do all businesses use these formal statements?

Isn’t this an unwieldy approach to keeping track of transactions?

CoLooNooU~LNE
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Part 1: September 1-17

Coolspring Furniture — Set A General Journal - Key

Coolspring Furniture
Chart of Accounts
8/31/2014
Account Account
Classification ~ Number Account Title Classification Number Account Title
Assets Revenue
101 Cash 401  Sales
103 Payroll Cash 402 Sales Returns & Allow.
105  Petty Cash Cost
122 Accounts Receivable 501 Purchases
131 Merchandise Inventory 502 Purch. Returns & Allow.
141 Office Supplies 503 Purchases Discounts
142 Store Supplies 504 Freight-in
145 Prepaid Insurance Expenses
Long-Term Assets 511 Sales Salaries Expense
161 Land 512 Advertising Expense
171 Buiiding 513 Bank Credit Card Expense
172  Accum. Depr. - Building 5i4  Store Supplies Expense
181  Store Equipment 515  Travel & Entertain. Exp.
182 Accum.Depr.-Store Equip. 518 Depr.Expense-Store Equip.
183 Office Equipment 522 Office Salaries Expense
184  Accum.Depr.-Office Equip. 523 Office Supplies Expense
Liabilities 525  Telephone Expense
202  Accounts Payable 530  Payroll Taxes Expense
211  Emp. Fed. Inc.Tax Payable 533 Utilities Expense
212 Soc. Sec. Tax Payable 534 Charitable Contrib. Exp.
213 Medicare Tax Payable 535  Insurance Expense
214  Emp.State Inc.Tax Payable 540  Depr. Expense - Building
215  Emp. Gity Inc.Tax Payable 541 Depr.Expense-Office Equip
218 Sales Salaries Payable 549 Miscellaneous Expense
219 Office Salaries Payable Other Revenue
221 FUTA Tax Payable 55¢ RentRevenue
222 SUTA Tax Payable Other Expenses
231 Sales Tax Payable 551 Interest Expense
241 Unearned Rent Revenue 552 Cash Short and Over
Long-Term Liabilities
251 Mortgage Payabie
Capital
311 Oliver Hayden, Capital
312 Dliver Hayden, Drawing
313 Income Summary




2 Coolspring Furniture — Set A General Journal - Key

Coolspring Furniture A
Trial Balance
9/17/2014
Account
Number  Account Title Debit Credit
101 Cash 106,396.97 -
103 Payroll Cash 1,000.00 -
105 Petty Cash 350.00 -
122 Accounts Receivable 8,658.75 -
131 Merchandise Inventory 115,750.00 -
141 Dffice Supplies 1,580.00 =
142 Store Supplies 1,459.15 -
145 Prepaid Insurance 8,100.00 -
161 Land 75,000.00 -
171 Building 200,000.00 -
172 Accum. Depr. - Building - 20,500.00
181 Store Equipment 10,275.00 -
182 Accum. Depr.-Store Equip. - 1,225.00
183 Office Equipment 13,525.00 -
184 Accum.Depr.-Office Equip. - 1,850.00
202 Accounts Payabile - 16,966.85
211 Emp. Fed. Inc.Tax Payabie - 565.00
212 Soc. Sec. Tax Payable ~ 1,021.02
213 Medicare Tax Payable ~ 238.80
214 Emp.State Inc.Tax Payable - 1,212.30
215 Emp. City Inc.Tax Payable - 380.60
221 FUTA Tax Payable - 44 69
222 SUTA Tax Payable - 193.55
231 Sales Tax Payable - 10,520.39
241 Unearned Rent Revenue - 15,000.00
251 Mortgage Payable - 248,724.74
311 Oliver Hayden, Capital - 176,914 .46
312 Oliver Hayden, Drawing 26,575.00 -
401 Sales - 927,561.70
402 Sales Returns &Allowances 12,675.00 -
501 Purchases 549,570.00 -
502 Purch. Returns&Allowances - 3,584.45
503 Purchases Discounts - 7,094 45
504 Freight-in 11,551.00 -
511 Sales Salaries Expense 134,550.00 -
512 Advertising Expense 9,819.00 <
513 Bank Credit Card Expense 31,999.09 -
515 Travel&Entertain. Expense 22,650.00 -




COMPREHENSIVE PROBLEM 2: ACCOUNTING CYCLE WITH SUBSIDIARY LEDGERS GENERAL
JOURNAL INSTRUCTIONS
PART 1: DECEMBER

1. Restore the file TJ's Specialty Shop CP2 (Backup).QBB.

From the File menu, click Open or Restore Company. Select Restore a backup copy and click Next.
Select Local backup, and then select TJ's Specialty Shop CP2 (Backup).QBB from the CD on which
your data files are provided. Click Next when the Open or Restore Company window appears. Key a
new file name of TJ's Specialty Shop CP2 Your Name.QBW (for example, TJ's Specialty Shop CP2
John Doe.QBW).

2. The accounts listed in your text for this problem have already been opened for you.

To view the Chart of Accounts, select Chart of Accounts from the Lists menu or click on Chart of
Accounts under Company from the home page. To view a list of customer accounts, click on Customer
Center and select the Customers & Jobs tab. All active customers will be listed at the left of the
window. To view a list of vendor accounts, click on Vendor Center and select the Vendors tab. All active
vendors will be listed at the left of the window.

3. Enter the December 16-30 transactions in the General Journal, using a base year of 2015.

From the Company menu, select Make General Journal Entries. When a message window appears,
click OK. Key the date of the transaction in the Date field, or click on the calendar icon and select the
date. For Year 1, use a date of 2015 for all entries. Click in the Account column and select the account to
be debited from the drop-down list. Tab to the Debit column and key the amount. Tab to the Memo
column and key an explanation to the entry. Tab to the Name column and select a customer or vendor
from the drop-down list if applicable. Tab to the next row and in the Account field, select the account to
be credited. Tab over and enter the amount in the Credit column. Select a customer or vendor from the
drop-down list if applicable. Click Save and New to continue to the next transaction or Save and Close if
you are finished entering transactions. If a Retained Earnings or Fixed Assets alert window pops up, click
OK and continue. For all Sales Tax Payable transactions, you must select a vendor; assume all taxes will
be paid through Connecticut State Bank.

4. Generate a General Journal report.

From the Reports menu, select Accountant & Taxes and then Journal. When the Journal window
appears, select December 16, 2015 in the From field and December 30, 2015 in the To field. Click on
Modify Report and unselect Trans#, Type, and Num. and click OK. Then click the Refresh button. For
columns in which copy is getting truncated, you may wish to expand the width of the column. Do this by
placing the cursor on the diamonds between the column heads, and when it turns to a cross with left
and right arrows, drag the cross right to expand the width of the column. To print the report, click on the
Print button.

5. Make corrections if necessary.

To correct general journal entries, click the Previous button in the General Journal window until the
transaction you wish to correct appears. Make the needed changes and click Save and New or Save
and Close as appropriate. Click Yes when asked to verify the change. To delete an entry, right click
while the cursor is anywhere in the entry and select Delete General Journal (only the current entry will
be deleted). Click Yes when asked to verify the deletion.

6. Generate a pre-adjusted Trial Balance report.

From the Reports menu, select Accountant & Taxes and then Trial Balance. When the Trial Balance window
appears, click on Modify Report and select December 16, 2015 in the From field and December



31, 2015 in the To field. Click on the Advanced button in the Modify Report window and under Display
Rows, select Non-zero. Click OK to close the Advance Options window, and then click OK again to
close the Modify Reports window. Then click the Refresh button to display the report with the new
settings. To print the report, click on the Print button.

7. Prepare adjusting entries for the year ended December 31, 2015.

Using the Trial Balance report and the adjustment information provided in the text, enter the adjusting
entries in the General Journal. For each entry, key "Adjusting Entry" in the Memo column. In
QuickBooks, you will need to adjust inventory in a different manner than shown in the text. First,
determine the amount of the adjustment by deducting the new inventory balance from the old inventory
balance. In the General Journal window, click on the Account drop-down list and select <Add New>.
Select Other Account Types and Cost of Goods Sold. Click Continue, and then key Inventory
Adjustment as the new account name. Click Save & Close. Continue entering the journal entry,
debiting Inventory Adjustment and crediting Merchandise Inventory for the adjustment amount.

8. Generate an adjusted Trial Balance report.
Generate the Trial Balance report as instructed in Step 6.
9. Generate a schedule of accounts payable.

From the Reports menu, select Vendors & Payables and then Vendor Balance Summary. When the
Vendor Balance Summary window appears, click on Modify Report. Select December 16, 2015 in the
From field and December 31, 2015 in the To field. Click OK to close the Modify Reports window. Then
click the Refresh button to display the report with the new settings. To print the report, click on the
Print button.

10. Generate a schedule of accounts receivable.

From the Reports menu, select Customers & Receivables and then Customer Balance Summary.
When the Vendor Balance Summary window appears, select December 16, 2015 in the From field
and December 31, 2015 in the To field. Then click the Refresh button (or press Enter). To print the
report, click on the Print button.

11. Generate an income statement.

From the Reports menu, select Company & Financial and then Profit & Loss Standard. When the
Profit and Loss window appears, select January 1, 2015 in the From field and December 31, 2015 in
the To field. Then click the Refresh button (or press Enter). To print the report, click on the Print button.

12. Generate a statement of owner's equity

The statement of owner's equity is not a standard option. To display the desired information, customize a
Balance Sheet report. From the Reports menu, select Company & Financial and then Balance Sheet
Standard. W hen the Balance Sheet window appears, select December 31, 2015 in the As of field. Click
the Refresh button (or press Enter). Then click on Modify Report and the Filters Tab. In the Account
drop-down list, select All equity and income/expense and click OK. To print the report, click on the
Print button.

13. Prepare closing entries for the year ended December 31.
Using information from the adjusted Trial Balance report, enter the closing entries in the General

Journal. For each entry, key "Closing Entry" in the Memo column. Remember to close out the Inventory
Adjustment account with the other expenses.



14. Generate a post-closing Trial Balance report.
Generate the Trial Balance report as instructed in Step 6.
15. Generate a Balance Sheet report.

From the Reports menu, select Company & Financial and then Balance Sheet Standard. W hen the
Balance Sheet window appears, select December 31, 2015 in the As of field. Click the Refresh button
(or press Enter). To print the report, click on the Print button.

16. Enter the reversing entry in the General Journal.

Reverse the adjusting entry for wages payable as of January 1, 2016. Key "Reversing Entry" in the
Memo column.

17. Save a backup file of your work.

From the File menu, select Save copy or backup. Select Backup copy and click Next. Select Local
backup and click Next. Select Save it now and click Next. Choose the drive/folder in which you want to
save your work and key a file name, such as TJ's Specialty Shop CP2 Dec Your Name
(Backup).QBB, and click Save. Submit your backup file to your instructor if requested.

PART 2: JANUARY
1. Enter the January 1-27 transactions in the General Journal, using the year 2016.

From the Company menu, select Make General Journal Entries. When a message window appears,
click OK. Key the date of the transaction in the Date field, or click on the calendar icon and select the
date. For Year 2, use a date of 2016 for all entries.. Click in the Account column and select the account to
be debited from the drop-down list. Tab to the Debit column and key the amount. Tab to the Memo
column and key an explanation to the entry. Tab to the Name column and select a customer or vendor
from the drop-down list if applicable. Tab to the next row and in the Account field, select the account to

be credited. Tab over and enter the amount in the Credit column. Select a customer or vendor from the
drop-down list if applicable. Click Save and New to continue to the next transaction or Save and Close if
you are finished entering transactions. If a Retained Earnings or Fixed Assets alert window pops up, click
OK and continue. For all Sales Tax Payable transactions, you must select a vendor; assume all taxes will
be paid through Connecticut State Bank.

2. Generate a General Journal report.

From the Reports menu, select Accountant & Taxes and then Journal. When the Journal window
appears, select January 1, 2016 in the From field and January 27, 2016 in the To field. Click on Modify
Report and unselect Trans#, Type, and Num., and click OK. Then click the Refresh button. For
columns in which copy is getting truncated, you may wish to expand the width of the column. Do this by
placing the cursor on the diamonds between the column heads, and when it turns to a cross with left and
right arrows, drag the cross right to expand the width of the column. To print the report, click on the Print
button.

3. Make corrections if necessary.

To correct general journal entries, click the Previous button in the General Journal window until the
transaction you wish to correct appears. Make the needed changes and click Save and New or Save
and Close as appropriate. Click Yes when asked to verify the change. To delete an entry, right click
while the cursor is anywhere in the entry and select Delete General Journal (only the current entry will
be deleted). Click Yes when asked to verify the deletion.



4. Generate a pre-adjusted Trial Balance report.

From the Reports menu, select Accountant & Taxes and then Trial Balance. When the Trial Balance window
appears, click on Modify Report. select January 1, 2016 in the From field and January 31, 2016 in the To
field (be sure to select dates of the year used for Part 2 journal entries). Click on the Advanced button in the
Modify Report window and under Display Rows, select Non-zero. Click OK to close the Advance Options
window, and then click OK again to close the Modify Reports window. Then click the Refresh button to display
the report with the new settings. To print the report, click on the Print button.

5. Prepare adjusting entries for January.

Using the Trial Balance report and the adjustment information provided in the text, enter the adjusting
entries in the General Journal. For each entry, key "Adjusting Entry" in the Memo column. Remember
to use the Inventory Adjustment account for the Merchandise Inventory adjustment, as described in
Part 1, Step 7.

6. Generate an adjusted Trial Balance report.
Generate the Trial Balance report as instructed in Step 4.
7. Generate a schedule of accounts payable.

From the Reports menu, select Vendors & Payables and then Vendor Balance Summary. When the
Vendor Balance Summary window appears, click on Modify Report. Select January 1, 2016 in the From field
and January 31, 2016 in the To field. Click OK to close the Modify Reports window. Then click the Refresh
button to display the report with the new settings. To print the report, click on the Print button.

8. Generate a schedule of accounts receivable.

From the Reports menu, select Customers & Receivables and then Customer Balance Summary.
When the Vendor Balance Summary window appears, select January 1, 2016 in the From field and
January 31, 2016 in the To field. Then click the Refresh button (or press Enter). To print the report,
click on the Print button.

9. Generate an income statement.

From the Reports menu, select Company & Financial and then Profit & Loss Standard. When the
Profit and Loss window appears, select January 1 in the From field and January 31 in the To field.
Then click the Refresh button (or press Enter). To print the report, click on the Print button.

10. Generate a statement of owner's equity

The statement of owner's equity is not a standard option. To display the desired information, customize a
Balance Sheet report. From the Reports menu, select Company & Financial and then Balance Sheet
Standard. W hen the Balance Sheet window appears, select January 31, 2016 in the As of field. Click
the Refresh button (or press Enter). Then click on Modify Report and the Filters Tab. In the Account
drop-down list, select All equity and income/expense and click OK. To print the report, click on the
Print button.

11. Prepare closing entries for January, 2016.

Using information from the adjusted Trial Balance report, enter the closing entries in the General Journal.
For each entry, key "Closing Entry" in the Memo column.

12. Generate a post-closing Trial Balance report.



Generate the Trial Balance report as instructed in Step 4.

13. Generate a Balance Sheet report.

From the Reports menu, select Company & Financial and then Balance Sheet Standard. W hen the
Balance Sheet window appears, select January 31, 2016 in the As of field. Click the Refresh button
(or press Enter). To print the report, click on the Print button.

14. Save a backup file of your work.

From the File menu, select Save copy or backup. Select Backup copy and click Next. Select Local
backup and click Next. Select Save it now and click Next. Choose the drive/folder in which you want to
save your work and key a file name, such as TJ's Specialty Shop CP2 Jan Your Name (Backup).QBB
, and click Save. Submit your backup file to your instructor if requested.



COMPREHENSIVE PROBLEM 2: ACCOUNTING CYCLE WITH SUBSIDIARY LEDGERS SPECIAL
JOURNALS INSTRUCTIONS

PART 1: DECEMBER
1. Restorethe file TJ's Specialty Shop CP2 Special Journals (Backup).QBB.

From the File menu, click Open or Restore Company. Select Restore a backup copy and
click Next. Select Local backup, and then select TJ's Specialty Shop CP2 Special Journals
(Backup).QBB from the CD on which your data files are provided. Click Next when the Open or
Restore Company window appears. Key a new file name of TJ's Specialty Shop CP2 Special
Journals Your Name.QBW (for example, TJ's Specialty Shop CP2 Special Journals John
Doe.QBW).

2. Theaccounts listed in your text for this problem have already been opened for you.

To view the Chart of Accounts, select Chart of Accounts from the Lists menu or click on Chart of
Accounts under Company from the home page. To view a list of customer accounts, click on
Customer Center and select the Customers & Jobs tab. All active customers will be listed at the
left of the window. To view a list of vendor accounts, click on Vendor Center and select the Vendors
tab. All active vendors will be listed at the left of the window.

3. Enter the December 16-30 transactions as
follows: a. For cash receipts:

(1) From customers on account: Select Receive Payments from the Customers menu.
(If prompted to complete an interview, click No.) In the Received From field, select a
customer from the drop-down list. Enter/select a date in the Date field. (Caution: For all Part
1 transactions, be sure to choose a date for December 2015.) In the Memo field, key Cash
Receipt (key in exactly this way for all transactions to aid in generating the Cash Receipts
Journal report later). In the Deposit to field, select Cash. (If asked if you want QuickBooks
to automatically determine payment amounts, click No.) Key the amount received in the
Amount field, which should also automatically populate the Payment column/field below,
but if necessary, key the amount in both places. All other fields may be left blank. (If alerted
that the payment is less than the full amount owed, select to Leave this as an
underpayment.) Click Save & Close.

(2) From cash customers: Enter this transaction in the general journal, as described for "e.
To record all other transactions” below. In the Memo field, key Cash Receipt (key in exactly
this way for all transactions to aid in generating the Cash Receipts Journal report later).

Your first cash receipt on account transaction should appear as follows:
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For sales on account:

Select Create Invoices from the Customers menu. In the Customer field, select a customer from the drop-down list. Enter/select a
date in the Date field. (Caution: For all Part 1 transactions, be sure to choose a date for December 2015.) Key the invoice number in
the Invoice # field. Key a 1 in the Qty. field. In the Item Code field, select the code for the group of merchandise that matches the
invoice number (for Invoice 640, this is Iltem Code 640). The

description, price, tax, and total invoice amount should immediately be entered/calculated for you. (If sales tax is not included, be sure
Tax is selected in the Tax column (at right of Amount

column) and Sales Tax is selected in Tax field near bottom.) All other fields may be left blank. Click Save &



